Table of Contents

Overview 6

Overview 6
Sample Company – Attic Designs 7
List Navigator 7
What’s New in Version 5.0 9

Getting Started 11

Getting Help 11
Defining Tool Classes 11
Organizing Tools 12
Bar Coding 12
Organizing Users 13
Organizing Sites 13
Organizing Kits 13

Installation 14

Installing the Program 14
Single User 15
Peer-to-Peer Network 15
Dedicated Server Network 15
System Setup 16
Company Setup 17
Setup System Users (optional) 18

Implementation Tasks 20

Master Lists 20
Class List 20
Vendor List 21
Quick Vendor Setup 22
Site List 23
Location List 24
Status List 25
Tool Kit 25
Kit Assignments 27
Tool List 28
Clone a Tool 32
Print your own Barcode Labels 32
Print Tool List 33
User List 33

**Daily Operations** 36
- Open Company 36
- Checking Out Tools and Kits 36
  - Printing a Receipt at Check Out 39
- Checking In Tools and Kits 39
- Assigning Tools and Kits to Sites 41
- Tool Audit 42

**Reports** 44
- Inquiry by Tool 44
- Inquiry by User 45
- Viewing the Activity Log 46
- Custom Tool Lists 47
  - Report Title 48
  - Print Destination 49
  - Data Selection/Sequence 50
  - Sort By 50
  - Select By 50
  - Sort Order 51
  - Orientation 51
  - New Page 51
  - Double Space 51
- Repair History 51

**Utilities** 52
- Backing up the Database 52
  - Manual Backup 53
  - Scheduled Backup 54
- Purging the Tool History 55

**Appendix A** 56
- Custom Report Builder 56
  - Introduction 56
  - A Quick Test Spin 58
Overview

Small Tool Tracking is a program designed to maintain a list of tools and to assign them to the employees, trucks, job sites, warehouses, tool boxes, and other locations responsible for the care of the tools. By making tool users accountable for their tools, an organization can save substantially by reassigning or repairing tools rather than purchasing new ones.

The tools are subdivided into classes for organizational purposes. For example, you may have a tool class called saws with specific tools within that class such as circular saws, jig saws, chain saws, and concrete saws. Tools can also be assigned to a kit if you always check out a group of tools together.

Users are individuals who are responsible for certain tools in your tool inventory. A user may be a person, a truck, a tool box, or whatever is appropriate for your business. In the setup screen, you can actually specify the program’s terminology to suit your needs. For instance, you may change the User label to Truck if that is more appropriate for your use. You may also set up sites to which you can assign tools. These sites may be long term job sites or satellite offices of your main office.

With the Tool List, User List, and Site List in place, you can Check Out tools to users and/or sites. The tool is assigned to the user and an entry is made in the Activity Log file. Reports can be printed By Tool, By User, or By Site so you can see who has which tools and also where the tools have been assigned. Tools can then be Checked In once a User is finished using the tools.
Sample Company – Attic Designs

Loading the program will automatically load a Sample Company – Attic Designs which you can use to practice with while building the framework of your company’s tool system.

To access the Sample Company, click on File, Open Company and select Attic Designs from the drop-down list.

Notice that the name of the company in the Windows title bar has changed. To go back to your “real” database, follow the same procedure and select New Company.

List Navigator

The List Navigator controls the movement through and maintenance of the list it controls. Note: Not all List Navigators will contain all 15 of these buttons, but each bar will contain at least some of them.

The title and function of each button is listed beside its corresponding number in the list below:

1. Move to First Record – Moves you to the beginning of the list.

2. Move Backward One Page – Pages the list up.

3. Move Backward One Record – Moves you up one row in the list.

4. Move Forward One Record – Moves you down one row in the list.

5. Move Forward One Page – Pages the list down.

6. Move to Last Record – Moves you to the end of the list.
7. **Insert** – Inserts a new line in the list.

8. **Delete** – Deletes the currently selected row.

9. **Edit** – Puts the list in an edit mode for the row selected. Selecting a row and keying changes will also put the list in an edit mode.

10. **Post Changes to the Current Record** – Saves changes made to the current row. Changes are also saved by tabbing or scrolling to another row in the list. While these changes are saved, they can be altered by selecting the row and clicking the Edit button.

11. **Cancel** – Cancels pending changes and reverts to a browse mode from the edit mode. This key is useful when errors persist or when an additional line has been accidentally inserted.

12. **Refresh** – Synchronizes the data in the list with the database. This button is useful when someone else on your network has changed data and you want to refresh your screen so it will display the updated data.

13. **Bookmark** – You may mark a selected row in a list by clicking on the bookmark button. Then you may return to the bookmarked row by clicking on the Return to Bookmark button.

14. **Return to Bookmark** – Returns you to the row you bookmarked.

15. **Filter** – This function allows you to include or exclude rows based on criteria you define. For example, you can list all tools in the saw class.

16. **Locate or Search the Dataset** – This function is useful when trying to find a tool or user in a long list. In addition to the line item’s ID, you may search most other values in the dataset, such as a phone number or a tool serial number.
What’s New in Version 5.0

There are many new features included in Small Tool Tracking version 5.0. They may be broken down into three broad categories – Flexibility, Extensibility, and the Data Security.

Flexibility

Many reports included in the system can now be modified and new tool reports generated easily using a report tool which gives the user the option to select columns of data, selection criteria, sort order, and much more. This capability is easy to use by the average computer user.

On many screen lists, you may now move columns and select columns to include on screens such as Check Out, Check In and Activity Log.

You may now define a tool to represent a single tool or multiple identical tools such as scaffolding frames, hammers, ladders or helmets.

You may now check out tools to a user and reassign the site during check out and check in.

A “Select User” drop-down list has been added to the Check In screen to easily filter tools by user.

Extensibility

In addition to being able to change the name of many of the fields in the system, there are custom fields added to the tool list allowing the user to extend the information in the Tool List.

A Tool Status List has been added giving you the option of extending the status list with user defined values.

Employee Badge ID may now be assigned and bar codes scanned (if available) to locate employees during Check In, Check Out and ByUser inquiries.
A user-defined Location List has been added to define the location of the tool in the warehouse.

A company logo can be added on the Company Setup screen and used to print on the Check In and Check Out Receipts.

A Tool Audit feature has been added to easily identify tools checked out to a user or on a site and audit the user or site's tools.

**Data Security**

Two new backup features have been added to insure multiple copies of the database are available in case of system failure – one manually executed and one that may be scheduled of overnight processing.
Getting Started

Getting Help
There are several ways, listed below, to receive help with the Small Tool Tracking program.

- Printed Documentation sent with the software.
- Help menu at the top of the Small Tool Tracking Program.
- Help button on the side bar while in any screen in the software will give you help on a particular function.
- Go to our web site at www.smalltooltracking.com and select Support. You can also go directly to that site by choosing Online Support from the Help Menu.
- Email us at support@landmarkdata.com or select email Landmark in the Help Menu.
- Call us at 1(800)424-8178.

Defining Tool Classes
The first step in using the Small Tool Tracking program is to set up tool classes. Entering classes into the Class list is explained in more detail later in this manual. These classes are used to divide the tools into broad categories for organizational purposes. Be specific in assigning Tool Classes. A few broad categories may not be as helpful as more detailed ones. Your list may look like this.
<table>
<thead>
<tr>
<th>CLASS</th>
<th>TOOL ID</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>circsaws</td>
<td>Skil-9382</td>
<td>Skil 6&quot; circular saw</td>
</tr>
<tr>
<td>circsaws</td>
<td>Skil-9328</td>
<td>Skil 8&quot; circular saw</td>
</tr>
<tr>
<td>circsaws</td>
<td>B&amp;D9832</td>
<td>Black &amp; Decker 8&quot; circular saw</td>
</tr>
<tr>
<td>chainsaws</td>
<td>P930243</td>
<td>Poulan 18&quot; chain saw</td>
</tr>
<tr>
<td>chainsaws</td>
<td>S49X933</td>
<td>Homelite 16&quot; chain saw</td>
</tr>
<tr>
<td>jigsaws</td>
<td>BD9303</td>
<td>Black &amp; Decker jig saw</td>
</tr>
<tr>
<td>jigsaws</td>
<td>MIL903</td>
<td>Milwaukee jig saw</td>
</tr>
</tbody>
</table>

**Organizing Tools**

Once you have entered your tool classes you may begin entering your Tool List. The Tool List is the master list of tools owned by the company. Entering and editing tools in the Tool List will be explained in more detail later in this manual. The Tool List allows you to define each tool in your inventory and assign it an individual Tool ID. In the Tool List you will assign the tool to the particular Class, discussed in the previous section, to which it belongs. Also you have the ability to enter the serial number, manufacturer, vendor, purchase date, warranty information, and more about the tool to help you identify it. With the Tool List you are able to add a picture of the tool for easier recognition. You may enter as much or as little information about the tool as needed to organize and identify your tool inventory.

**Bar Coding**

Bar coding your tools is an optional part of the Small Tool Tracking software. You have the ability with the Small Tool Tracking software to assign a bar code ID to some or all of your tools. The program supports corded and cordless bar coding scanners. To receive a list of supported bar code scanners contact Landmark Data Systems, Inc. Bar coding provides another way to identify and organize your tools. Scanning bar
codes provides a more convenient method to check-in or check-out your tools.

---

**Organizing Users**

The User List is a list of the individuals, trucks, tool boxes or other places where the tools may be checked out. Entering and editing users in the User List will be explained in more detail later in this manual. The User List allows you to enter a unique User ID for each user. You can also enter the users name, address, phone number, fax number, email address, supervisor, and other information that will allow you to identify and organize the User List.

---

**Organizing Sites**

The Site List is a list of the job sites, satellite offices, or other places where tools are assigned. Entering and editing sites in the Site List will be explained in more detail later in this manual. The Site List allows you to enter a unique Site ID for each site. You can also enter the name, address, phone number, fax number, supervisor, and other information that will allow you to identify and organize the Site List.

---

**Organizing Kits**

Tool Kits are collections of tools that may be treated as a single unit. Entering and editing tool kits in the Kits List will be explained in more detail later in this manual. For example, you may have a toolbox which includes a hammer, screwdriver, pliers and flashlight. While each tool must be listed in the Tool List, it may be associated with a Kit and checked out and in by referencing the Kit ID rather than each individual tool. After creating the tool kits you must use the Kit Assignment tab to assign tools to the kits. Entering and editing kits in the Kit Assignment tab will be explained in more detail later in this manual. Tool Kits may be bar coded just like Tools.
Installation

Installing the Program
Find the Small Tool Tracking CD and place it in the CD drive. The install program should auto-start. If it does not, use Windows Explorer to navigate to your CD drive and double-click on the AUTORUN.EXE program in the CD root directory. Follow the instructions. If in doubt, accept the default value offered.

Make sure no one is using Small Tool Tracking while you perform the installation. The program will show the following screen.
**Single User**

For users that have Small Tool Tracking only on one computer, click on the Single User Installation and follow the instructions. When the program installation has completed, go into Small Tool Tracking and allow it to update the database if necessary.

**Peer-to-Peer Network**

In a Peer-to-Peer network there is not a dedicated server but rather a workstation that also has the database running on it.

For new installations only, install the Server on the machine that will host the Small Tool Tracking database. Select the Server button and follow the onscreen instructions. During this process, a DOS-like black window will open. WAIT until this screen closes on its own before completing the installation.

Also install the Network Client on this workstation.

Now install the Network Client only on all remaining workstations.

**Dedicated Server Network**

For new installations only, install Small Tool Tracking on the dedicated server by inserting the CD and selecting Server. A window will pop up verifying that you are installing the server portion of the software. Follow the onscreen instructions. During this process, a DOS-like black window will open. WAIT until this screen closes on its own before completing the installation.

Next install the Network Client only on each workstation by inserting the CD in each workstation, allowing the installation program to start, clicking on Network Client and following instructions.
System Setup
Click on File, then System Setup.

This window is used to personalize the program for your company. The labels for User, Tool, Class, Kit, Site, Location and custom fields are provided for you to change the nomenclature in the program. For example, you may wish to use Job Site in place of User. By changing this label, the term Job Site will appear in place of User in all windows and on all printouts.

The Database section indicates version information about the current database in use and the licensed and current user connections.

The Country Settings section allows you to select the type of currency you would like the program to use. It also provides a space to set the format for the date.

The Registration Section gives you an opportunity to enter a specially provided unlock code to release all features of the program making it a full working copy rather than a demo. Upon entering an acceptable
unlock code, the words "(Demo version)" will disappear from the title caption Small Tool Tracking.

This unlock code is provided by Landmark upon receipt of payment. The Registration Code is uniquely defined for each installation of the program and the installation date is available for reference.

**Company Setup**

Click on File, then Company Setup.

Initially, the company listed as CO# 1 will display with the name “New Company.” You will change this entry to your company by entering your company’s information in the **Company Name**, **Address**, **Phone**, and **Fax** fields.

In the Company Logo Section, you may load a JPG graphic image of your company’s logo for printing on Check Out and Check In Receipts. By default your company name and address will be printed.

If you wish to use user names and passwords in order to control which employees have access to the Small Tool Tracking system, click on the
Users/Passwords box to place a check mark in it.

Click on the check mark button in the List Navigator to post this information. If necessary, you may add more companies to this list. To access a company’s database while working in a different company’s database, simply click on File, then Open Company. Select the desired company using the drop-down menu and click the OK button.

Setup System Users (optional)

In the Company Setup screen, make sure the Users/Passwords box has a check mark in it, indicating the feature is enabled. Click on the User button to open the User Profile screen. Every company has a user called SYSTEM with the default password LANDMARK. This user name and password give you access to the User Profiles screen, where employees are assigned a password and given a permission status.

Click on the plus button to insert an entry into the user list. In the User ID column, enter an identification reference (e.g., last name and first initial) for each employee. Enter the employee’s name in the Name column. Save the entry by clicking on the check mark button or by tabbing to the next row. Repeat this process until all employees are entered.
Select an employee and enter his or her password in the **Password** field. Leave the field blank if you do not want to assign a password.

To select the modules to which the employee will have access, click on the **Permissions** tab. A check mark in the box next to a module indicates the user will have access to that module. To uncheck a box, indicating the employee will not have access to the box’s corresponding module, double-click on the box.
Implementation Tasks

Master Lists
Master Lists are tables of information that provide the basic framework for the system. After initialized they don’t change often.

To access these lists, click on Master Lists above the main toolbar.

Class List
A Class is a subdivision of tools into broad categories for organizational purposes. Be specific in assigning Tool Classes. A few broad categories may not be as helpful as more detailed ones. An example of the Class List screen is shown below. To add a new Class press the “+” symbol and fill in the appropriate fields. The Class List fields are explained below the screen image.
**Class ID**
Enter a unique ID number for the class. This ID will be used to assign tools to each Class.

**Description**
Enter a description of the Class to further identify it.

**Vendor List**
You may add new vendors here by entering a Vendor ID, name, address and other information about the vendor. The vendor list is used in the Tool Setup to select manufacturer and vendor values. It is also used in the Repair/Maintenance screen to select a vendor value. The vendor list is an optional part of the Small Tool Tracking program and is not required to setup your tool list. Once you add this vendor, it is immediately available for selection from the vendor list. An example of the Vendor List screen is shown below. To add a new Vendor press the “+” symbol and fill in the appropriate fields. The Vendor List fields are explained below the screen image.
Vendor ID  A unique ID number to identify the Vendor. This ID will be used to assign tools to specific Vendors.

Name  Enter the Name of the Vendor.

Address  Enter the Address of the Vendor.

Phone  Enter the phone number of the Vendor.

Fax  Enter the fax number of the Vendor.

Email Address  Enter the email address of the Vendor if applicable.

Contact  Enter the Contact person for the Vendor.

Quick Vendor Setup
You also have the ability to setup a Vendor using the **Quick Vendor Setup**. When setting up a tool and when entering data into the Repair/Maintenance screen you have the ability to use the Quick Vendor Setup. Press the “…” button under the select a vendor or manufacturer
and a window will pop up allowing you to select a vendor from a list. While on this screen press the “setup” button on the Task Bar to enter the Quick Vendor Setup. Then enter the Vendor ID and other information to quickly setup a new vendor.

**Site List**

The Site List is a simple list of the job sites, satellite offices, or other places where tools are assigned. An example of the Site List screen is shown below. To add a new User press the “+” symbol and fill in the appropriate fields. The Site List fields are explained below the screen image.

![Site List](image)

**Site ID**  
A unique ID number for the Site. This ID number will be used to identify the site when checking in and out tools.

**Name**  
Enter the Name of the Site.

**Address**  
Enter the Address of the Site.
**Phone**  Enter the phone number of the Site.

**Fax**  Enter the fax number of the Site.

**Email Address**  Enter the email address of the Site if applicable.

**Supervisor**  Enter the Site Supervisor if applicable.

**Location List**

The Location List is a list of the warehouse bins, shelves, or other places where tools may be located in the warehouse or tool crib. An example of the Location List screen is shown below. To add a new User press the “+” symbol and fill in the appropriate fields. The Location List fields are explained below the screen image.

**Location ID**  A unique ID number for the Location. This ID will be used to identify the location of the tool when checking in and out tools.

**Description**  Enter the Description of the Location.
Status List

The Status List is a list of statuses that may be applied to tools. The list is initialized with four common values but may be expanded if necessary. An example of the Status List screen is shown below. To add a new Status press the “+” symbol and fill in the appropriate fields. The Status List fields are explained below the screen image.

Status ID
A unique ID number for the Status.

Description
Enter the Description of the Status.

Tool Kit

Tool Kits are collections of tools that may be treated as a single unit. An example of the Tool Kits screen is shown below. To add a new Tool Kit press the “+” symbol and fill in the appropriate fields. The Tool Kit fields are explained below.
**Kit ID**  
A unique ID number for the Kit. This ID number will be used to identify the Kit when checking in and out tools.

**Class ID**  
Select the kit class from the previously entered list by clicking on the down arrow at the right of the entry box.

**Bar Code ID**  
This is an optional field for use with the Bar Code scanning feature of the program. Enter a unique Bar Code number either by manually typing the Bar Code number or by selecting the field and then scanning the Bar Code with the Bar Code Scanner. This ID number will be used to identify the tool when checking in and out tools.

**Status**  
Choose the status of the kit from the drop-down menu.

**Description**  
Enter a description of the tool kit.
Location ID  
Choose the kit location when checked in at the 
warehouse or tool crib. (optional)

Site ID  
Choose the kit site location when checked out for 
use. (optional)

Value  
The value of all tools in the kit is automatically 
calculated as tools are put in or removed from a kit 
or a tool value in a kit is changed.

Notes  
Make notes here about the tool kit. These may be 
updated periodically to build a diary of information 
about the tool kit.

Kit Assignments

After creating the tool kits you must use the Kit Assignment tab to assign 
tools to the kits. An example of the Kit Assignments screen is shown 
below.

To assign a tool to a tool kit first select the tool kit in the upper left 
window. The available tools not already assigned to a tool kit will appear 
in the right window. Select the tool you would like to add and a press 
the left arrow button beside the bottom left window.

To select multiple tools hold the Ctrl key and select your tools. The tool 
will then appear in the bottom left window and will be a part of that tool 
kit.

To remove a tool from a tool kit select the tool in the bottom left window 
that you wish to remove and press the right arrow button next to the 
bottom left window. The tool will then appear in the tool list in the right 
window and will no longer be a part of the tool kit.
Tool List

The Tool List is the master list of tools owned by the company. Prior to entering this information, you should have entered the Class List, Site List, and Location List. If you are going to add vendors or manufacturers to further define your tools you should also have the Vendor List setup before adding tools. The grid list at the left of the screen is used to easily select an item for viewing or editing. Enter or change data in the field to the right of the screen only. An example of the Tool List screen is shown below. To add a new Tool press the “+” symbol and fill in the appropriate fields. The Tool List fields are explained below the screen image.
Tool ID

Enter a unique ID number for the tool. This number should be assigned to easily identify the tool from its physical appearance.

Description

Enter here a description of the tool such as 8" Dewalt circular saw.

Bar Code ID

This is an optional field for use with the Bar Code scanning feature of the program. Enter a unique Bar Code number either by manually typing the Bar Code number or by selecting the field and then scanning the Bar Code with the Bar Code Scanner. This ID number will be used to identify the tool when checking in and out tools.

Class ID

Select the tool class from the previously entered list by clicking on the down arrow at the right of the entry box.
**Small Tool Tracking**

**Status**
Choose from the drop-down list the current status of this tool. The default is “available.”

**Site ID**
Optionally you may associate this tool with a site as previously defined in the Master Lists. Choose from the drop-down list.

**Location**
The Location refers to the place in the warehouse or tool crib where the tool is stored when checked in. It is an optional feature that you may select from the drop-down list.

**Manufacturer**
Enter here the manufacturer of the tool.

**Model**
Enter here the tool model number.

**Serial Number**
Enter here the tool’s serial number.

**Vendor**
Enter here the name of the vendor from whom the tool was purchased.

**Tool Type**
Tool types are either Single or Multiple. A single tool represents one individual tool such as a circular saw or conduit bender. A multiple tool type represents more than one of identical tools such as six foot ladders or scaffolding frames and bracing.

**Quantity**
If the Tool Type is Multiple, enter the total number of tools represented by this Tool ID.

**U/M**
Enter the Unit of Measure.

**Cost**
Enter the Cost. In the case of a Multiple Tool Type, enter the cost of one tool.

**Warranty**
Enter here the tool warranty in months.
**Purchase Date**  Enter here the purchase date. You can use the down arrow at the right of the entry box to pull up a calendar to pick a date.

**Due Date**  If the tool is to be returned, calibrated or inspected on a certain date, enter it here for use in printing a Due Date Report.

**Custom Fields**  Five fields are provided to allow for user defined information. These fields can be labeled in the System Setup and are 15 alphanumeric characters in length.

**Take Picture**  This button allows you to take a picture of the tool with an attached video camera for easier identification. After clicking this button a dialog window will open allowing you to capture the picture and select it for use.

**Load Picture**  This button allows you to add a picture of the tool for easier identification. After clicking this button a window will open allowing you to browse to the picture file on your computer or attached device. The file types must be either a jpg, jpeg, or bmp.

**Erase Picture**  This button will appear after you have added a picture of the tool. This button allows you to delete the picture of the tool you have previously added.

**Notes**  Make notes here about the tool. These may be updated periodically to build a diary of information about the tool.

The tool list screen also gives you the ability to clone a tool, print the tool list, and print bar code labels. You will see these buttons on the right side of the screen in the Task Bar.
Clone a Tool

If you have several tools that are of the same type and you do not wish to enter each tool individually you may clone the tool. Enter the information for the first tool and then press the **Clone Button**. A window will pop up, enter the Tool ID for the new tool and press the “Clone It” button. The program will create a new tool with the new Tool ID you entered and exactly the same data as the cloned tool except for the Tool ID, Barcode ID, Due Date, and the notes. Repeat these steps to create the remaining cloned tools.

Print your own Barcode Labels

You have the ability to print your own Barcode Labels. Using the **Barcode** button on the Task Bar you can design and print your own Barcode Labels. The Barcode Label window will display a text box that will print on your labels.

![Barcode Label Window](image)

The text box will display your company name and phone number by default. Click in the text box to type the information you would like to appear on the Barcode Labels.

Right click in the box to bring up a menu that will allow you to change the font style, font size, add a logo, and other options. After you have entered the information you must enter the serial numbers for the
Barcodes. This must be a number. You can not enter decimals, dashes, alphabet characters, or any other symbols.

If you are printing on a partial sheet of labels, you may indicate a beginning column and row. The labels print vertically downward.

If your printer doesn’t align correctly, you may use the Vertical Offset to move the print up with a negative number or down with a positive number.

Next enter the number of labels to print and press the **Print** button.

The Barcodes are designed to print on Avery 5160 labels. You can also save your design in order to print more bar codes later.

**Print Tool List**

Using the print button on the Task Bar, you may print out the entire tool list or a specific section of the tool list. You can also sort the list in a variety of ways.

Refer to the section on Reporting for details on customizing and printing reports.

**User List**

The User List is a list of the individuals, trucks, tool boxes or other places where the tools are checked out. An example of the User List screen is shown below. To add a new User press the “+” symbol and fill in the appropriate fields. The User List fields are explained below the screen image.
User ID
A unique ID number for the User. This ID number will be used to identify the user when checking in and out tools.

Badge ID
This is an alternate identifier for the employee and is used when scanning an employee's badge or company ID card during Check Out, Check In or By User inquiries.

Take Picture
This button allows you to take a picture of the user with an attached video camera. After clicking this button a dialog window will open allowing you to capture the picture and select it for use.

Load Picture
This button allows you to add a picture of the user. After clicking this button a window will open allowing you to browse to the picture file on your computer or attached device. The file types must be either a jpg, jpeg, or bmp.
Erase Picture  This button will appear after you have added a picture of the user. This button allows you to delete the picture of the user you have previously added.

Name  Enter the Name of the User.

Title  Enter the User’s title.

Address  Enter the Address of the User.

Phone  Enter the phone number of the User.

Fax  Enter the fax number of the User.

Email Address  Enter the email address of the User if applicable.

Supervisor  Enter the User’s Supervisor if applicable.
Daily Operations

Open Company
The Open Company screen appears when you first open the Small Tool Tracking Program. This screen allows you to select a company to open and choose your User ID. If you have only a single company and only one user that does not have a password setup the Open Company screen will not appear. Once you are in the program you can also switch companies by clicking File and then Open Company. The Open Company screen will appear allowing you to change companies or change users.

Checking Out Tools and Kits
To check out or assign a tool or tool kit, follow the steps outlined below. The User List, Class List and Tool List must be entered prior to using the Check Out routine.
Step 1: Select a date. Use the down arrow at the right of the entry field to display a calendar from which you may pick a date.

Step 2: Select a user. Click on the down arrow at the right of the entry field to bring up a list of users from which to choose. You must pick a valid user from the list. If the user is not in the list, click on Master Lists to add the user.

If you have entered Badge IDs in the User’s List, click in the “Select User” edit box and scan the user’s badge to select the user.

Step 3: Select a site. If the tool’s site is changing, select the new site from the drop-down list; otherwise, leave <nochange>.

Step 4: Select a tool by clicking on a tool or tool kit in the list. Tools that are assigned to a tool kit and unavailable tools will not appear in this list. To select multiple tools hold the Ctrl key and select your tools. To scroll down in the list, use the scroll bar at the right of the grid or the...
Page Down key on your keyboard. You may change the sort order of the list by clicking on the appropriate heading. To view the list by user, click on the word USER in the title. Likewise, you may click on TOOL or CLASS to sort the list by tool or class, respectively.

To select a tool by bar code, simply scan the bar code while this screen is open. The scanner will find and highlight the tool in the Tool List just as if you had selected it with the mouse. You may scan several tools prior to check out.

If you have saved pictures of the tools, you can double click on a tool row to display the picture.

You may view a list of tools that are assigned to certain sites or view the entire list of tools or tool kits. Click on the drop down arrow at the right of the Select a Site entry field to bring up a list of sites from which to choose. You must pick a valid site from the list or select the all tool category. If the site is not in the list, click on the Master Lists to add the site. Assigning tools to a site will be explained further later in this documentation.

**Step 5:** Click on the Check Out button to save the assignment. You will be prompted with a confirmation question at which time you may abort the assignment.

**Customizing the Check Out Tool List**

You may customize the Check Out tool list by selecting which columns you want to display and dragging the title bar to adjust the position and size of each column.

Click on  in the upper right corner to display a list of available columns. Click in the check box to the right of the column title to select or de-select that column. Click OK when done.

To move a column right or left in the grid, click and hold the mouse in the center of the title bar and drag the column to its new location. To resize a column,
click and hold the mouse on the right side of the title bar and move left to shorten or right to lengthen. When you close this screen, these adjustments will be saved.

**Printing a Receipt at Check Out**

Using the Options button on the Task Bar, you may choose to print a receipt of the Check Out activity.

Click the check box “Print Receipt?” to activate and select the desired tool to print on the receipt – either the entire user’s inventory of tools or just those being checked out currently.

You may also select which columns of information to print on the receipt by checking the check box to the left of the column title in the list. Since there is limited space on the receipt, you cannot pick all columns.

![Check Out/In Receipt Options](image)

**Checking In Tools and Kits**

To check in a tool or tool kit, follow the steps outlined below. The User List, Class List and Tool List must be entered prior to using the Check In routine.
Step 1: Select a date. Use the down arrow at the right of the entry field to display a calendar from which you may pick a date.

Step 2: Select a tool by clicking on a tool or tool kit in the list. Only tools that are checked out are displayed in this list. To select multiple tools hold the Ctrl key and select your tools. To scroll down in the list, use the scroll bar at the right of the grid or the Page Down key on your keyboard. You may change the sort order of the list by clicking on the appropriate heading. To view the list by user, click on the word USER in the title. Likewise, you may click on TOOL or CLASS to sort the list by tool or class, respectively.

To select a tool by bar code, simply scan the bar code while this screen is open. The scanner will find and highlight the tool in the Tool List just as if you had selected it with the mouse. You may scan several tools prior to check in.
**Step 3:** Click on the Check In button to save the assignment. You will be prompted with a confirmation question at which time you may abort the assignment.

You may customize the Check In list in the same way as the Check Out list. See “Customizing the Check Out Tool List” above.

Using the Options button on the Task Bar, you may choose to print a receipt of the Check In activity. See “Printing a Receipt at Check Out” above.

---

**Assigning Tools and Kits to Sites**

To assign a tool or tool kit to a site, follow the steps outlined below. The User List, Class List, Tool List, and Site List must be entered prior to assigning tools to a site.

![Assign tool to site interface](image)

**Step 1:** Select a date. Use the down arrow at the right of the entry field to display a calendar from which you may pick a date.

**Step 2:** Select a site. Click on the down arrow at the right of the entry field to bring up a list of sites from which to choose. You must pick a valid site from the list. If the site is not in the list, click on Master Lists to add the site.
**Step 3:** Select a tool by clicking on a tool or tool kit in the list. To select multiple tools hold the Ctrl key and select your tools. To scroll down in the list, use the scroll bar at the right of the grid or the Page Down key on your keyboard. You may change the sort order of the list by clicking on the appropriate heading. To view the list by site, click on the word SITE in the title. Likewise, you may click on TOOL or CLASS to sort the list by tool or class, respectively.

To select a tool by bar code, simply scan the bar code while this screen is open. The scanner will find and highlight the tool in the Tool List just as if you had selected it with the mouse. You may scan several tools prior to check out.

**Step 4:** Click on the Assign button to save the assignment. You will be prompted with a confirmation question at which time you may abort the assignment.

As with the Check Out and Check In grids, you may move and resize the columns in this list. To move a column right or left in the grid, click and hold the mouse in the center of the title bar and drag the column to its new location. To resize a column, click and hold the mouse on the right side of the title bar and move left to shorten or right to lengthen. When you close this screen, these adjustments will be saved.

---

**Tool Audit**

From time to time it is helpful to do an audit of tools held by a user, on a site or in the tool crib. This activity aids in that process and may be done at random times.

To perform an audit, click on the Audit button on the main Tool Bar. The following screen will appear.
To initiate an audit, click on the plus sign in the upper List Navigator to add a row in the upper grid. The date and time will default to the current date and time.

Next select the Scope of the audit – Site, User, All Tools. If you select Site or User, now select to ID from the next drop-down list and then type a Title for the audit. Click the check mark in the List Navigator to save the entry. At this point the lower grid will be populated with the tools in the scope defined above.

At this point click on Reports button and print a Tool Audit Worksheet. Use this report to check for tools, indicating the quantity found on in the space provided.

Finally you can check the OK box in the left column of the lower grid and print either a Discrepancy Report or a full Tool Audit Report.

The Discrepancy Report lists those tools not found at which time you can investigate and correct issues involving the missing tools.
Inquiry by Tool

The “By Tool” window displays information on tools and the history of the tool assignment. Click on a tool in the left grid to display current information about the tool and the history of assignments.

You may sort the tool grid by USER, TOOL or SITE by clicking on the appropriate title in the tool grid. This may make it easier for you to find a particular tool. Additionally, search and filter dialogs feature can be found at the top right of the tool list to help locate tools and filter the list to a smaller subset of tools.
To print a report of the Tools listed by class, simply click on the Print button to the right. A window will pop up giving you a chance to print the report or further customize the report. (See “Custom Tool Lists” below.)

After selecting a tool you can also add, edit or view the Repair/Maintenance information for that tool by clicking on the Repair/Maintenance tab. You may also print a Repair/Maintenance history by clicking on the Print button on the right of the screen. A window will pop up allowing you to select a particular tool, group of tools, or the entire list of tools. The default is the tool you have selected.

---

**Inquiry by User**

This option allows you to display the tools assigned to a particular user and to review the tool history. Click on the user in the upper left grid and the tools assigned to the user will be displayed in the lower left grid. The history on the tool selected in the lower left grid will be displayed in the right grid.
You have three print options:

**Entire List**  
Prints a report of each user and the tools that are currently checked out to the user.

**Users Only**  
Prints a report of tools checked out to the user you select in the Select User grid.

**Unassigned**  
Prints a report of all tools that are not assigned to a user.

---

**Viewing the Activity Log**

This report displays the complete listing of tool assignments initially sorted by checkout date. You may display the list sorted by user, tool,
trx date, or class simply by clicking on the USER, TOOL, TRX DATE, or CLASS name in the grid title.

Additionally, you may select portions of the log by using the Filter button in the tool bar above the list for a single user, a single tool, a range of dates and more.

Print the Activity Log by selecting the Print button to the right.

## Custom Tool Lists

The Reports Menu contains options to review data on tools, users or assignment activity. Each report allows you to sort or select data and display the information on the screen with print options. The different reports that can be run from the Reports Menu will be explained below.

The Tool Lists section of the Reports Menu allows you to select amount multiple criteria as listed on the screen below.
Report Title

Eight pre-defined reports are listed in the drop-down list. These reports may be changed but not deleted. To create a new report, type in a new title, select your report criteria and save the report. It will be saved in the report list. User defined custom tool reports may also be deleted.

The eight pre-defined reports may be accessed by clicking on Reports in the Main Menu and then Tool Lists and the desired report. Also, you may click on Reports in the Tool Bar and select the desired report from the drop-down list.

**By Tool ID**
Sorted by Tool ID’s.

**By Class ID**
Sorted by Class ID and then Tool ID, grouped and totaled, where appropriate, by Class ID.
By User ID  Sorted by User ID and then Tool ID, grouped and totaled, where appropriate, by User ID.

By Site ID  Sorted by Site ID and then Tool ID, grouped and totaled, where appropriate, by Site ID.

By Due Date  Sorted by Due Date.

By Location ID  Sorted by Location ID and then Tool ID, grouped and totaled, where appropriate, by Location ID.

Unassigned Tools  Sorted by Class ID and then Tool ID, grouped and totaled, where appropriate, by Class ID. Tools that are currently unassigned will appear in this report.

Unavailable Tools  Sorted by Class ID and then Tool ID, grouped and totaled, where appropriate, by Class ID. Tools that have a Status set to anything other than available will appear in this report.

Print Destination

This drop-down list allows the report to be viewed on the screen, printed to any available printer or saved in a variety of file formats. They are Adobe PDF, Excel Report or Data Only, JPEG graphic format, RTF (Rich Text File) or DOC (Microsoft Word). When selecting one of the file formats, you must enter a file name for your report at the bottom of the Print screen shown below.
**Data Selection/Sequence**

To select columns of data for your report, click in the check box to the left of the column title. To reposition the order on the report, click on the column title to select it and use the up/down arrows to move the column to the desired position. The report columns are printed left to right selected top to bottom.

**Sort By**

Use this drop-down list to select the order in which the tools will be listed.

**Select By**

Use this drop-down list to choose the column on which to select a range of values and Beginning and Ending to select those values.
Sort Order
Choose to either sort the selected column chosen in Sort By box by Ascending or Descending values.

Orientation
Select the page orientation—portrait or landscape.

New Page
Some Sort By selections are two tiered like User ID+ Tool ID. Check this box is you wish to start a new page for each primary sort column, in this case User ID.

Double Space
Check this box to double space the report.

Repair History
This option allows you to print a repair history report of the entire tool list, a single tool or a specific range of the tool list. This report may be selected from the By Tool, Repair/Maintenance tab or from the Main Menu, Reports.

When you select this option a window will pop up allowing you to customize the report. Use the drop down arrows to choose a range of tools. The default is set to run a report on the entire tool list.

After you have made your selections press the “Print It” button to display the results of your report. You may print this result screen by selecting the print button in the top left hand corner of the report.
Utilities

Backing up the Database

Backing up your database is the process of saving a copy of your Small Tool data files on CDs, zip disks, or other storage media. If your computer’s hard disk is backed up through a network server or by some other means, you may prefer to back up the database on your computer’s C drive.

Daily backup is the only way to protect your company from the catastrophic loss of data that can result from computer failure. If you experience data loss, technicians at Landmark can replace your programs and your original database, but it will be impossible for them to recreate your modified database if you have not backed it up.

In order to have extra copies of your database (in case a copy is destroyed), create at least three backup sets. Label them A, B, and C and use the oldest set each time you backup.

Backing up is a simple process, and it should become a daily activity that should never be ignored. It should become as much of a habit as turning on and off your computer each day. It is important to note that the destination drive must be large enough to receive the entire backup as it will not split the backup onto multiple disks.

There are two methods backing up your data from within Small Tool Tracking – manual and scheduled.
Manual Backup

To perform a manual backup of your data, click on File, then DB Backup.

Enter the drive and/or file to which you wish to backup your data in the Step 1 field. If you wish, you may use the System Setup screen to specify a default backup area, a process that is explained in the next paragraph. This path is relative to the drive on which the database server is running. In a single user configuration, it will be the local computer. In a network configuration, it will be the computer on which the database server is running. A manual backup is most often done on single user installations and should take no more than a few minutes.

To backup the data, click on the Backup button next to Step 2.
Scheduled Backup

Alternatively, you may choose to schedule a backup to be done automatically at a prescribed time of the day. This method is most often used in networked versions of Small Tool Tracking to occur just prior to a scheduled server backup to a tape drive, external USB drive or other large capacity backup device.

To configure a scheduled backup, click on File and then Scheduled Backup.

On this screen, enter the path to the backup directory. This directory must exist and is on the database server not the local workstation.

Enter the time of the day you want this backup to occur, check the days of the week and then click Enable Schedule.

Be sure to test the backup before leaving the setup.
This backup will backup Small Tool Tracking data only and will create two files – ST32.DB and ST32.LOG in a folder for each selected day of the week.

---

**Purging the Tool History**

As tools are checked out and passed from person to person, a history of tool assignments is created. After a period of time, you may wish to purge a portion of this history.

This may be done by selecting the Purge Tool History option from the File Menu. History records will be purged through the date indicated.

This information doesn’t occupy a significant portion of the database, so if you don’t reassign tools regularly, thereby creating a large history, you probably won’t need to purge often.

Deleting a tool automatically purges the history for that tool.
Appendix A

Custom Report Builder

Introduction
Welcome to Learning ReportBuilder, a series of tutorials developed to teach you how to create custom reports. The tutorials will teach you the basics of how to use the ReportBuilder.
DESIGN

The Report Designer, pictured above, is the application you will use to build reports. It contains three workspaces: Data, Design, and Preview. When first displayed, the Report Designer defaults to the design workspace because this is where you will spend the majority of your report-building time. The design workspace is divided into two areas: the workbench and the canvas. The workbench is comprised of toolbars, component palettes, rulers, and other tools that can be used to manipulate the canvas. The canvas is the area that contains the report layout. This is where the bands and components that will ultimately control the content of each page of the report are placed.

PREVIEW

The preview tab plays an integral role in the report creation process because it allows you to see how the report will look when printed. As you work through the tutorials, you'll notice that this workspace is frequently accessed so that you can see how the report is shaping up. You will make many changes and corrections based on what is seen in this workspace. The tools in this space allow you to view each page of the report or zoom in to get a better look at a specific page. You can also print the report from the preview workspace.

DATA

The data workspace is often the key to successful report creation because it allows the user to select and manipulate the data needed for a given report. These tasks are accomplished via two visual tools: the Query Wizard and the Query Designer. These tools greatly simplify the often-difficult task of data selection by giving us the ability to select data without requiring an in-depth knowledge of databases. Once the data is selected, we can begin laying out the report. The primary purpose of a report is to transform raw data into information. The task of report builders is essentially to make data meaningful. The following tutorials will show you how to do just that.

ABOUT THIS BOOK
As you work through this guide, it is important to keep in mind that the tutorials build on one another. Each tutorial produces some kind of report and brings to light important aspects of ReportBuilder.

A Quick Test Spin gives you a glimpse of the Report Designer’s report-building potential.

Calisthenics offers a series of exercises that prepare you for the tutorials. You will be a nimble user when you complete the calisthenics.

The Summary Tutorial concentrates all that you learned in Calisthenics into a report.

---

A Quick Test Spin

OVERVIEW

This simple exercise provides an introduction to the Report Designer, the Query Wizard, and the process of building reports. The purpose of this tutorial is to show you what it takes to build a report, so if this exercise starts to feel a little over your head, don't worry. We will cover the meaning behind the actions in later tutorials. The final report for this tutorial should contain the following items:

- A list of Tool IDs
- The class that each tool belongs to
- A description for each tool

Note: In order to follow along with this tutorial you need to select company two for the demo data.

GETTING STARTED
It will be helpful for you to become familiar with the following set of directions because you'll repeat this process to begin each report.

1. Click the New Report icon on the main toolbar.

2. Click on the Data tab.

3. Select File | New in order to access the New Items dialog.

4. Double-click on the Query Wizard icon. The Query Wizard will come up with a list of Available Tables.

**QUERY WIZARD**

The *Query Wizard* is a tool that allows you to access information from your database to use in your report.

1. Choose the Tool list Table by double-clicking on it. The Tool list table should now appear in the list of Selected Tables.

2. Once the Tool list table is selected, click the Next button.

3. Keep clicking the Next button until you reach the screen with the Set Order option.

4. Click on the Set Order button.

5. Double-click on Tool list.ToolID so it appears in the list of Selected Fields.

6. Click Finish.

7. You've officially completed your first query via the Query Wizard. You'll notice a new window in the upper left-hand corner of the data workspace. This is a *dataview*. It represents the data, which is selected from the database each time the report is generated.

8. Click on the Design tab in order to begin laying out your report.
DESIGN WORKSPACE

The design workspace is the environment in which you will build reports. Whatever you put in the header band (the white space above the word 'Header') will appear at the top of each page of the report; whatever you put in the detail band will be the body of the report, and whatever you put in the footer band will appear at the bottom of each page of the report.

Task 1

Place and Name Labels

1. Locate the label icon on the toolbar.
2. Click on the icon.
3. Click in the white space of the header band in order to create a label.
4. Repeat steps 1 through 3 to create two more labels in the header band.
5. Select 'Label1'.
6. Locate the edit toolbar (below the label component icon on the toolbar). It should contain the text 'Label1', which is the caption of the currently selected label.
7. Highlight the text in the edit toolbar and type ToolID.
8. Select Label2 and type Class into the edit toolbar.
9. Select Label3 and type Description into the edit toolbar.

Task 2
Save the Report

1. Press Ctrl + S to save your work.

2. A dialog box will appear that looks like this:

3. Expand the drop-down list at the top of this dialog by clicking on the arrow icon. Select 'All Folders' from the list. This will allow us to save the report in this folder.

4. At the bottom of the dialog you should see an edit box that contains the report name. The default name is 'New Report.' Select the text and change the name to 'Quick Tool List'. Click the Save button.

5. Close the Report Designer. Notice that your new report is listed in 'All Folders'.

6. Double-click on Quick Tool List to return to the design workspace.

**Task 3**

**Bold the Text in the Labels**

1. Select the ToolID label.
2. Hold down the Shift key and then click on the other two labels. All three labels should now be selected. You can tell that they are selected by the small gray boxes surrounding each label. These boxes are called selection handles.

![Image showing selected labels]

3. Click the bold icon. All three label captions should turn bold.

**Task 4**

Create and Choose Data for DBText Components

1. Locate the DBText icon on the toolbar.

2. Click on the icon.

3. Click in the white space of the detail band in order to create a DBText component.

4. Change the text from bold to regular by clicking on the bold icon.

5. Repeat steps 1 through 3 to create two more DBText Components in the header band.


7. Notice that there are two drop-down list boxes in the upper left-hand corner of the Report Designer. The drop-down list box on the left contains the dataset from the dataview. The dropdown on the right contains the fields.

8. Select 'ToolID' from the drop-down list box containing the fields.

10. Choose 'ClassID' from the drop-down list.

11. Select DBText3.

12. Choose 'Description' from the drop-down list box.

**Task 5**

Adjust the Label Components

1. Right-click the 'ToolID' label and select Position.

2. Set the left to 0.1 and click 'OK'.

3. Right-click the 'ClassID' label and set the left to 1.5 then click 'OK'.

4. Set the 'Description' label left to 3.0.

5. Right-click the 'ToolID' label and select Position.

6. Set the 'top' to 0.3 and click 'OK'.

7. Select the 'ToolID' label.

8. Hold down the Shift key and click on the other two labels. All three labels should now be selected.

9. Launch the Align or Space toolbar by selecting View | Toolbars and clicking on Align or Space. The toolbar should appear under the drop-down list boxes.

10. Click the Align Top icon. The 'ClassID' and 'Description' labels should align with the 'ToolID' label.

**Task 6**
Adjust the DBText Components

1. Right-click the ‘ToolID’ DBText.
2. Set the width to 1.3.
3. Set the ‘ClassID’ DBText width to 1.3.
4. Set the ‘Description’ DBText width to 3.0.
5. Select the ‘ToolID’ DBText and set the top to 0.0.
6. Shift-click the other DBTexts so that they are all selected.
7. Click the Align Top icon on the Align or Space toolbar.

**Note:** The DBText components may overlap. That's fine. The next task will correct the overlap.

**Task 7**

Align the Components

1. Select the ‘ToolID’ label and shift-click the ‘ToolID’ DBText.
2. Click the Left Align icon. The DBText component should be positioned directly beneath the label and both components should be aligned left.
3. Left align the ‘ClassID’ label and the ‘ClassID’ DBText.
4. Left align the ‘Description’ label and the ‘Description’ DBText.
5. Press Ctrl + S to save your work.

**PREVIEW**
The preview window in the Report Designer environment works the same way as the preview capability in other Windows applications: it shows you how your report will look when it is printed.

1. Click on the Preview tab and look at your report. Make sure that the columns are spaced evenly with plenty of room for long names.

2. Everything should look good except for the rows, which are double-spaced. That spacing takes up too much room and will waste paper when the report is printed.

**FIXES**

When you preview a report, you’ll undoubtedly find something that can be improved. Let’s fix the spacing.

1. Return to the design workspace by clicking on the Design tab.

2. Place your cursor over the gray bar labeled Detail. Your cursor will change to an up/down arrow, indicating that you can drag the section divider up and down.

3. Drag the divider up until it meets the bottom of the components in the detail band.

4. Preview the report once more. It should look like this:
5. Close the Report Designer window by clicking the button at the upper right corner of the window.

6. A dialog box asking you to ‘Save Changes' will appear. Click Yes.


**Calisthenics**

**OVERVIEW**

These exercises will get you oriented in the Report Designer environment and teach you to use some basic tools. It’s a good idea to study this section because each task is extremely detailed, whereas the other
exercises will assume that you are familiar with the basics and therefore be less explicit.

Note: In order to follow along with this tutorial you need to select company two for the demo data.

**COMPONENT CREATION**

The first thing you need to know in order to write a report is the significance of the canvas. The canvas is divided into sections called bands. A band is labeled in the section divider immediately below it; thus, the first band is called the 'header', the second is called the 'detail', and the third is called the 'footer'. When the report generates, the bands are printed on different parts of the page. There are many different band types for different occasions, but for now we’ll just use the header, detail, and footer bands.

Let’s create some components and put them in the bands. A *component* is an element used to control how the report looks. Each component has a unique purpose.

1. Click the New Report icon on the main toolbar. The Report Designer will appear with the design workspace active.

2. Click the Label icon.

3. Click in the white space of the header band. You’ve just created a label component.

4. Repeat steps 2 and 3 to create two more labels in the header band.

5. Locate the shape icon on the toolbar.

6. Click the icon.
7. Click in the white space of the header band in order to create a shape.

8. Press Ctrl + S to save your work. Name the report Cal1. Save at the end of each task.

**Note:** You can use the process of clicking the icon, then clicking in a band to create any type of component.

**BAND ADJUSTMENT**

Notice that the shape doesn’t quite fit in the header band. We can remedy this by increasing the height of the band.

1. Locate the ruler on the left side of the workspace.

2. Place your cursor over the divider labeled 'Header'. Your cursor will change to an up/down arrow, indicating that you can drag the divider up and down.

3. Hold down the left mouse button and drag the divider up and down. Notice the two little lines that appear on the vertical ruler to the left of the divider. These lines are called *guides* because they represent the new position of the divider.

4. Increase the height of the header band by dragging the divider until the guide reaches the one inch mark on the vertical ruler. In order to do this you must first drag the divider until the band height is greater than one inch. Then release and drag the divider up until the top guide hits the one inch mark.

**Note:** This method of changing the size of the header band works for all bands.

**BASIC COMPONENT SELECTION**

Once components are created, the real work begins, for each component needs to be carefully positioned in order to create a high-quality report.
1. Select the Label1 component by clicking on it.

2. Select the remaining components: hold down the Shift key and then click on the other two labels and the shape. All of the components should now be selected. You can tell that they are selected by the small gray boxes surrounding each component. These boxes are called *selection handles*.

   ![Selection Handles](image)

3. Click on the white space of the header band. Notice that the components are deselected.

4. Click on the white space to the left of the first label, hold down the left mouse button, and begin dragging the mouse down. A *bounding box* will appear.

5. Drag the mouse across the components until the bounding box encompasses all of the components.

6. Release the mouse button. All of the components will be selected.

7. Place your cursor over one of the components and drag in any direction. Notice how all of the components move in unison. This is called a component *selection*.

   **Note:** These are the two methods you can use to select multiple components: *the shift-click method* (hold down the Shift key and click the components) and *the bounding box method* (hold down the mouse button and outline the components).

**DOCKING TOOLBARS**

Toolbars are used to set the *properties* of a component. Here are a few examples of the kinds of properties a component may have: font size,
color, and font style. Before we can use the toolbars effectively, we must first learn how to position them within the Report Designer.

1. Launch the Draw toolbar by selecting View | Toolbars and clicking on Draw. The toolbar should appear in the upper left-hand corner of the Report Designer, above the horizontal ruler.

2. Locate the handle on the far left side of the toolbar.

3. Place the cursor over the handle and hold down the left mouse button.

4. Drag the mouse down and to the left until the rectangle pivots and appears as follows:

5. Release the mouse button. The toolbar is now docked vertically.

6. Drag the toolbar over the upper left corner of the header band.

7. Release the handle. The toolbar is now a floating window. The area at the top of the toolbar (labeled ‘Draw’) is called the title bar. You can move the window by placing your cursor over the title bar and dragging.
8. Click on the close button in the title bar. The toolbar will be closed.

9. Select View | Toolbars from the main menu of the Report Designer and click on Draw menu item. Notice that the toolbar returns to the same place it was before you closed it.

**Note:** When the toolbar is a floating window, you can close the toolbar by clicking the close button. You can always redisplay a toolbar by accessing View | Toolbars from the main menu.

10. Drag the toolbar to the upper right corner of the design workspace.

11. Release the handle. The toolbar is now docked horizontally.

**Note:** All toolbars have the same docking ability as the Draw toolbar.

**SIZING, ALIGNING, AND POSITIONING COMPONENTS**

In order to get all of the components lined up neatly or sized correctly, you must know how to size and align with dexterity.
**Sizing**

1. Deselect all components by clicking on the white space of the header band.

2. Select the shape component in the header band.

3. Place your cursor over the little black box on the right side of the shape and wait until the cursor changes to a left/right arrow. The little black boxes that surround the shape are called *sizing handles*.

4. Drag the cursor to the right and notice how the shape gets wider.

5. Place your cursor over the sizing handle on the bottom of the shape and wait for the cursor to change to an up/down arrow.

6. Drag the cursor down and notice how the label gets taller.

7. Place your cursor over the sizing handle on the right-hand corner of the shape and wait for the cursor to change to a diagonal arrow.

8. Drag the cursor diagonally. The shape gets both wider and taller.

9. Drag the shape to the left corner of the header band.

10. Move the shape up and down in the header band. Notice the guides on the vertical and horizontal rulers. Whenever you are dragging or sizing, the guides show you the position and size of the selection.
11. Use the guides to set the shape to ½ inch by ½ inch. The guides should match up with the ½ inch mark on both the horizontal and vertical rulers.

**Note:** You can also adjust the size of a component by selecting the component, then holding down the Shift key and pressing the arrow keys. You can use this method to size single and multiple component selections.

**Aligning**

1. If the Align or Space toolbar is not already visible, launch it by selecting View \ Toolbars and clicking on Align or Space. The toolbar should appear above the horizontal ruler.

2. Dock the Align or Space toolbar on the left side of the Report Designer.

3. Select the shape component in the header band.
4. Hold down the Shift key and then click on the three labels. All four components should now be selected.

5. Click the Align Top icon of the Align or Space toolbar. The labels should align with the shape.

6. Deselect the labels and select only Label3. Move Label3 to slightly above the bottom of the header band.

7. Select Label3 and Shift-click the other components in order to add them to the selection.

8. Click the Align Bottom icon of the Align or Space toolbar. The components should align with Label3.

**Note:** The first component selected in a multiselect is the one to which the others align.

**Positioning**

1. Deselect the components by clicking in the white space of the header band.

2. Select the shape.
3. Hold down the Ctrl key and press the up arrow several times to move the shape.

4. As you move the shape using this method, look at the status bar in the lower left-hand corner of the Report Designer. The Top measurement should track with the component's location.

5. Use the right arrow key to move the shape to the right. The Left measurement should track with the component's location.

6. Position the shape so that the Left is 0 and the Top is 0.0625

7. Deselect the shape.

8. Use the shift-click method to select the labels.

9. Using the arrow keys, position the selection at Left of 1.3021 and a Top of 0.3854.

**FRONT-TO-BACK ORDER**

This section illustrates how a component can be used as a background for other components.

**Task 1**

Create and Color Shapes

1. Create two more shapes near the first shape in the header band.

2. Select the first shape.

3. Locate the Fill Color icon on the Draw toolbar.

4. Click the down arrow button to the right of the icon. The Fill Color palette will be displayed.
5. Select yellow.
6. Select the second shape.
7. Set the color to aqua.
8. Select the third shape.
9. Set the color to purple.

**Task 2**

Overlap Shapes and Establish their Order

1. Position the aqua shape so that its corner overlaps the corner of the yellow shape.

2. Position the purple shape so that its corner overlaps the corner of the aqua shape. The three shapes should look like this:
3. Select the Preview tab. Notice that the shapes retain their front-to-back ordering.

4. Return to the design workspace.

5. Right-click over the purple shape.

6. Select the Send to Back menu option. Notice how the purple shape is now behind the aqua shape.

7. Right-click over the purple shape.

8. Select the Bring to Front menu option. The purple shape is once again in front of the aqua shape.

9. Right-click over the yellow shape.

10. Select the Bring to Front menu option. The yellow shape is now in front of the other two shapes.

11. Restore the original order of the shapes by deciding which shape needs to be sent to the back or brought to the front. (Answer: Send the yellow shape to the back.)
Task 3

Use a Shape as a Background

1. Right-click over the yellow shape.

2. Select the ParentHeight menu option. The shape’s height increases to match the band’s height.

3. Select ParentWidth. The shape’s width increases to match the band’s width. The other components appear in front of the shape because of the front-to-back order.

4. Right-click over the yellow shape.

5. Select the Bring to Front menu option. Notice how all of the components disappear from view.

6. Make the components reappear by right-clicking over the yellow shape and selecting the Send to Back menu option.

Note: Whenever you appear to have lost a component, try using the Send to Back method in order to find it: it may be behind another component.

ADVANCED COMPONENT SELECTION

This section explains how to select components in the foreground when you have a larger component in the background.

1. Try to select all of the components in the header band by clicking to the left of the first component, holding down the left mouse
button, and dragging the mouse (i.e. the bounding box method). Notice how the components cannot be selected. This is because the yellow shape is selected and no bounding box can be drawn.

2. Hold down the Ctrl key and try to select the components using the bounding-box method again. When the Ctrl key is held down, you will see a bounding box.

3. Expand the bounding box to encompass all of the components and release the mouse button. All of the components, including the yellow shape, should be selected.

4. Try to move the selected components. Notice how they appear to be locked in place. The selection cannot be moved because the yellow shape fills the band and has no where to go.

5. Hold down the Shift key and click the yellow shape.

Note: You can use the shift-click method to deselect any component that is part of a multi-selection.

6. Move the selected components. The components can be moved now because the yellow shape is deselected.

7. Try to deselect the components by clicking on Label1. Nothing happens. That’s because you must select an unselected component or click in the white space of a band in order to clear the current selection.

8. Deselect the components by clicking on the yellow shape.

ADVANCED SIZING

When you have a shape stretched using ParentWidth and ParentHeight, you cannot change the size via the sizing handles. This exercise shows you how to resize such a shape.

1. Place your cursor over the sizing handle on the left side of the yellow shape. The left/right arrow will be displayed.
2. Try to reduce the size of the shape by dragging the cursor toward the center of the header band. The shape can’t be modified because it is set to ParentWidth.

3. Right-click over the shape.

4. Select ParentWidth. The ParentWidth menu option is deselected. Now the shape’s width can be modified using the sizing handle.

5. Select ParentHeight. The ParentHeight menu option is deselected. Now the shape’s height can be modified using the sizing handles.

6. Use the sizing handles to modify the yellow shape so that it is about the same size as the other shapes.

Note: You may not be able to resize the shape so that it is exactly the same size as the others. The next section will address this issue by showing you a more precise way to resize shapes.

SPEED MENU

The speed menu appears when you right-click over a component. It offers different options for altering the overall look of your component via changes in shape, size, and visibility. Here is the speed menu for a shape:
By now you know about the following menu options: Bring to Front, Send to Back, ParentHeight, and ParentWidth. Next, we'll learn about the Position option, which will allow you to control the size and position of components more precisely.

**Task 1**

Set shape sizes

1. Select the labels and move them to the left until they reach a left of 3.7396 as indicated by the status bar.

2. Access the speed menu by right-clicking over the yellow shape.

3. Select Position . . . A dialog box like the one below will be displayed; however, the numbers may be slightly different from these. That's fine.
4. Set the Left to 2.0.
5. Set the Top to 0.2.
6. Set the Width to 0.5.
7. Set the Height to 0.5.

Task 2

Resize the Aqua Shape

1. Right-click over the aqua shape to access the speed menu.
2. Select Position. . . .
3. Set the Left to 3.0.
4. Set the Top to 0.2.
5. Set the Width to 0.5.
6. Set the Height to 0.5. The aqua shape should now be the same size as the yellow shape.
7. Set the Left of the purple shape to 1.
8. Set the Top to 0.3.
**Note:** The speed menu applies only to the component over which you have right clicked, regardless of the selection. Task 3 will illustrate this aspect of the Report Designer.

**Task 3**

Explore Component Properties and the RightClick Option

1. Select the aqua shape.
2. Shift-click the other two shapes in order to add them to the selection.
3. Right-click over the aqua shape.
4. Access the Position . . . dialog.
5. Set the Top to 0.1. Notice that even though the other shapes are selected, the aqua shape is the only component that moves. That’s because the aqua shape was the one over which we rightclicked.
6. Right-click over the purple shape.
7. Access the Position. . . dialog and set the Top to 0.2.
8. Right-click over the yellow shape.
9. Access the Position. . . dialog and set the Top to 0.3.
10. Right-click once again over the aqua shape and set the top to 0.0.
11. Click the Align Top icon on the Align or Space toolbar. All shapes should align with the top of the aqua shape because it was selected first.

**Note:** You can use this method whenever you need to set the size or position of several components to the same value.
Task 4

Save Your Work

1. Select File | Save from the main menu.


DATA TREE

The Data Tree allows you to build a report based on data you have selected from the database. In order to use the Data Tree, you must first select data by creating a dataview.

Task 1

Create a New Report

1. Click the New Report icon on the main toolbar.

2. Click on the Data tab.

3. Select File | New to access the New Items dialog.

4. Double-click on the Query Wizard icon.

Task 2

Create a Dataview Via the Query Wizard

1. The Query Wizard will come up with a list of Available Tables. Choose the Tool List table by double-clicking on it. The Tool List table should now appear in the list of Selected Tables.

2. Once the Tool List table is selected, click the Finish button.

3. You'll notice a new window in the upper lefthand corner of the data workspace. This is the dataview. It represents the data that
will be selected from the database each time the report is generated. In a later exercise, we will show you how to make modifications to a dataview. For now, let’s move on to building the report.

4. Click on the Design tab in order to begin laying out your report.

**Task 3**

Dock the Data Tree

1. Maximize the Report Designer window.

2. Select View | Toolbars | Align or Space to hide the Align or Space toolbar.

3. Select View | Toolbars | Report Tree to hide the Report Tree if it is visible.

4. Select View | Toolbars | Data Tree from the main menu.

5. Place your cursor over the bottom of the Data Tree until the cursor becomes an up/down arrow.

6. Hold down your left mouse button and drag the mouse down until you can see all of the field names listed in the bottom part of the Data Tree.

7. Click on the title bar of the Data Tree and drag it to the left, making sure that the toolbar is below the horizontal ruler.

8. Release the mouse button. The Data Tree should dock on the left of the workspace like this:
Task 4

Create a Vertical Report

1. Click on the Layout tab at the bottom of the Data Tree.

2. Select the vertical style.
3. Click on the Data tab at the bottom of the Data Tree.

4. Click the 'ToolID' field.

5. Hold down the Ctrl key and click the 'ClassID' field. Your selection should look like this:
6. Locate the divider labeled 'Detail' on the canvas of the design workspace.

7. Place your cursor over the divider. Your cursor should change to an up/down arrow, indicating that you can drag the divider up and down.

8. Increase the height of the detail band by dragging the divider until the guide reaches the one inch mark on the vertical ruler.

9. Position your cursor over the 'ToolID' field in the Data Tree and drag the selection into the detail band.

10. Release the mouse button. The components necessary to display the 'ToolID' and 'ClassID' fields in the report are created.

11. Click on the Preview tab. Notice how the labels repeat for each row of the data. This is called a vertical report because the components are laid out in a top-to-bottom fashion.
Task 5

Create a Tabular Report

1. Return to the design workspace.

2. Select all of the components created from the previous task and press the delete key.

3. Click on the Layout tab at the bottom of the Data Tree.

4. Select the tabular style.

5. Click on the Font icon for Labels.

6. A dialog box like this will appear:
7. Make the font style bold. Now any label created via the Data Tree will be bold.

8. Click the OK button on the Font dialog. Notice how the diagram at the top of the Data Tree reflects the change by bolding the word 'Company'.

9. Click on the Data tab at the bottom of the Data Tree.

12. Click the 'ToolID' field.

10. Hold down the Ctrl key and click the 'ClassID' field.

11. Position your cursor over the 'ToolID' field in the Data Tree and drag the selection into the lower left corner of the header band.

12. Release the mouse button. The components necessary to display the 'ToolID' and 'ClassID' fields are created. The labels are in the header band and the data is in the detail band.
13. Click on the Preview tab. Notice how the labels appear only once at the top of the page. This report is ‘tabular’ because the data is laid out in a left-to-right fashion.

**Task 6**

Create a Tabular Report with a Grid

1. Return to the design workspace and delete all of the components created in the previous task.

2. Click on the Layout tab at the bottom of the Data Tree.

3. Click the Grid check box for both Labels and Fields.
4. Click on the Data tab at the bottom of the Data Tree.

5. Click the 'ToolID' field.

6. Hold down the Ctrl key and click the 'ClassID' field.

7. Position your cursor over the 'ToolID' field in the Data Tree and drag the selection into the lower left corner of the header band.

8. Release the mouse button. Notice the boxes around the components. These shapes will give us the effect of a grid.

9. Use the bounding box method to select all of the components in the header band.

10. Remove the labels from the selection by holding down the Shift key and clicking on each label. Only the shapes should now be selected.

11. Locate the Fill color icon on the Draw toolbar and select light gray.

12. Drag the divider labeled 'Detail' up until it meets the bottom of the components in the detail band.

13. Click on the Preview tab. Notice the grid effect.

14. Save the report as Cal2 and close the Report Designer.
Summary Tutorial

OVERVIEW

This tutorial will solidify all of the report-building techniques you learned in Calisthenics. The final report should contain the following items:

• A list of Tool ID’s
• A list of Class ID’s
• A list of Vendor’s
• A Description of the tools

Note: In order to follow along with this tutorial you need to select company two for the demo data.

QUERY WIZARD

1. Click the New Report icon on the main toolbar.

2. Click on the Data tab.

3. Select File | New in order to access the New Items dialog.

4. Double-click on the Query Wizard icon. The Query Wizard will come up with a list of Available Tables.

5. Choose the Tool List table by double-clicking on it. The Tool List table should now appear in the list of Selected Tables.

6. Click Finish.

7. Access the design workspace.

DESIGN WORKSPACE
Task 1
Launch the Data Tree and Set Properties

1. If it is not already visible, launch the Data Tree toolbar.
2. Dock it on the left side of the workspace.
3. Click the layout tab of the Data Tree.
4. Set the Style to Tabular.
5. Deselect the Grid boxes if they are checked.
6. Click the font icon for Labels.
7. Set the Label font to Arial, Bold, 10.
8. Set the Field font to Arial, Regular, 10.
9. Click on the data tab of the Data Tree.
10. Press Ctrl + S to save your work. Save the report as Summary Tutorial. Save at the end of each task.

Task 2
Lay Out Components in the Detail Band

1. Place your cursor over the 'Detail' divider. Your cursor will change to an up/down arrow, indicating that you can drag the control up and down.

2. Increase the height of the detail band by dragging the divider down until the guide reaches the one inch mark on the vertical ruler.

3. Place a shape component in the detail band.

4. Set the shape's fill color and line color to yellow.

5. Right-click over the shape and select ParentHeight and ParentWidth.

6. Hold down the Ctrl key while you select the 'ToolID', 'ClassID', 'Vendor', and 'Description' fields in the Data Tree.

7. Drag the selection from the Data Tree into the lower left corner of the header band and release the mouse button. Labels should be created in the header band and DBTexts should be created in the detail band.

---

**Task 3**

Position the Components
1. Position the selection so that the labels line up with the bottom of the header band.

2. Deselect the components by clicking on the white space of the footer band.

3. Select all of the components in the detail band.

4. Shift-click the yellow shape to remove it from the selection.

5. Drag the selection up so that the components line up with the top of the detail band. The layout should look like this:

6. Deselect the components.

**Task 4**

Size the Components

1. Select the ‘ClassID’ DBText component in the detail band.

2. Use the sizing handle to make the component narrower. Size the component so that the guide lines up with the three inch mark on the horizontal ruler.

3. Shift-click the Company label in the header band.

4. Launch the Size toolbar.
5. Locate the Shrink Width to Smallest icon  and click on it. The label's width should shrink to match that of the DBText.

Task 5

Align the Components and Adjust the Detail Band

1. Select the 'Vendor' and 'Description' labels.

2. Shift-click the corresponding DBText components in the detail band.

3. Drag the selection until it reaches the 3 1/8 inch mark on the horizontal ruler.

4. Left justify the DBText 'ToolID' component in the detail band.

5. Drag the detail band divider up until it meets the bottom of the components.

Task 6

Lay Out the Footer Band

1. Click the System Variable icon  and click on it.

2. Click the lower left side of the footer band.

3. Select PrintDateTime from the drop-down list box in the upper left corner of the workspace. The date and time should appear in the component.

4. Place another system variable component in the lower right side of the footer band.

5. Select PageNoDesc (Page Number Description) from the drop-down list box. The page number should appear in the component.
6. Right justify the system variable by clicking the right-justify icon `Right`.

7. Align the tops of the system variables.

8. Press Ctrl + S to save your work.

**PREVIEW**

1. Click on the Preview tab and look at your report.

2. The data is solid yellow. Let's put white spaces between the data in order to differentiate the rows.

**FIXES**

1. Click the Design tab to return to the design workspace.

2. Right-click over the yellow shape.

3. Select ParentHeight.

4. Drag the detail band divider down until you can see a little white space below the shape. The layout should look like this:

![Image of layout with white spaces between data]

5. Preview the report once again. It should look this:
6. Close the Report Designer, saving the changes to the report.